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1. Software Overview 

Weather Message - WxReTran is an EMWIN data retransmission 
program.  It is used to retransmit EMWIN data on a VHF or UHF 
frequency using a radio modem.   
 
WxReTran features 10 priority message queues, message discarding, 
message duplication and message scheduling.  In addition, it can be 
used to compress single or multiple messages. 
 
A standard RS-232 connection to an external radio modem is used to 
transmit the EMWIN data at 1200, 2400 or 9600 baud.  Radio modems, 
suitable for EMWIN retransmission can be purchased at Tigertronics 
http://tigertronics.com or Zephyrus Electronics http://big-z.com .  See 
Appendix B for specifications. 
 
An appropriate radio transmitter and FCC license are required to 
broadcast the EMWIN data.  NOAA currently has frequencies available 
for EMWIN retransmission.  They are 163.300, 163.325, 163.350, 
168.7125, and 168.8125 MHz.  Contact your local Warning Coordination 
Meteorologist  (WCM) for information on applying for a frequency. 
 
Transmitters certified for use on the NOAA frequencies can be 
purchased from Skywarn Systems, Inc.  For information and pricing, 
send email to Ray Bartik – ray.bartik@skywarnsystems.com. 
 
Weather Message – WxBBSrvr is an EMWIN data retransmission 
program for the internet.  It is used to serve EMWIN data to a private or 
public network. 
 
Weather Message – WxRadar can be used to retrieve weather radar 
images for inclusion in your retransmission. 
 

2. Software Installation – General Notes 
Weather Message retransmission software can be purchased on CD or 
downloaded from the internet.  Navigate to your CD-Rom drive and click 
on WxReTrancd to start the installation process. 
  
If you download the software from the internet, you will need the full 
installation.  This install program is named WxReTrancd.exe.  It contains 
all of the files necessary for a full installation. 



 

  

  
Updates to the software can also be downloaded from the internet.  The 
program updates only contain changes to the retransmission programs.  
It cannot be used for a full installation.  The name of this file is 
WxReTranpt.exe. 
 
The retransmission programs can be uninstalled using the standard 
Windows Add/Remove Programs facility.  The uninstaller will not delete 
files created while running Weather Message.  After uninstalling the 
software, you can safely remove the WxMesg directory. 
 
Note:  It is not necessary to uninstall a previous version of the 
retransmission software before installing an updated software version.  
Uninstalling the software will delete its operating setup information. 
 

3. Software Installation – WxReTran 
To install WxReTran start the installation program WxReTrancd.exe.  
When asked for the installation directory, you should change it to 
c:\WxMesg.  Note:  If you have Weather Message installed on your 
computer, you should install WxReTran in the same directory as 
Weather Message. 
 
The following files are installed in the WxMesg directory. 
FillFile.txt Contains the filler message that is used when 

WxReTran does not have a weather message to 
send. 

RtMorse.txt Morse code translation file. 
RtList??.txt Priority list configuration files for WxReTran. 
RtSched.txt Scheduler configuration for WxReTran. 
WxSatus.txt A list of byte blaster servers for use by other byte 

blaster servers. 
WxSrvus.txt A list of byte blaster servers. 
WxByte.exe The WxByte executable file. 
WxIngest.exe The WxIngest executable file. 
WxPurge.exe  Support program for WxReTran. 
WxReg.dll Support program for WxReTran. 
WxReTran.exe The WxReTran executable file. 
 
The following files may appear in the WxMesg directory.  
 
IBLog.txt Contains messages generated by the ingest 

programs WxIngest and WxByte. 
IBLog.old Contains the previous log file. 



 

  

IBFiles.txt Contains the received file list. 
IBFiles.old Contains the previous received file list. 
RtLog.txt Contains messages generated by WxReTran.  This 

log contains statistics about program operation, and 
errors during program operation. 

RtLog.old Contains the previous log file. 
Logfile.txt Contains messages generated by the ingest 

programs. 
 
 
The following directories are created in the WxMesg directory.  
 
WxData   A directory to hold the processed messages. 
WxData\RxTemp A temporary storage directory for incoming files. 
WxData\RxTrack A directory to store message tracking files. 
WxData\RxFiles A directory that stores messages that have been 

received.  This is referred to as your ingest 
directory. 

WxData\RtXmit A directory to store files waiting to be transmitted. 
WxData\RtSent A directory to store files that are being sent or have 

been sent. 
WxData\RtPri?? There are 11 RtPri directories.  Directory 1 through 

10 are the priority queue directories.  Directory 11 
contains files that are waiting to be block 
compressed. 

  
After you have installed this software, it will appear in your Start 
Programs menu under the title “Weather Message”. 
 

4. Software Installation – WxBBSrvr 
To install WxBBSrvr start the installation program WxReTrancd.exe.  
When asked for the installation directory, you should change it to 
c:\WxMesg.  Note:  If you have Weather Message installed on your 
computer, you should install WxBBSrvr in the same directory as 
Weather Message. 
 
The following files are installed in the WxMesg directory. 
WxBBSrvr.exe The WxByte executable file. 
 
After you have installed this software, it will appear in your Start 
programs menu under the title “Weather Message”. 
 



 

  

5. Software Installation – WxRadar 
To install WxRadar start the installation program WxReTrancd.exe.  
When asked for the installation directory, you should change it to 
c:\WxMesg.  Note:  If you have Weather Message installed on your 
computer, you should install WxRadar in the same directory as Weather 
Message. 
 
The following files are installed in the WxMesg directory. 

WxRadar.exe  The WxRadar executable file. 
WxSites.dat  Contains the current radar sites. 
RadLog.txt  Contains messages generated by WxRadar. 
RadLog.old   Contains the previous log file. 
RadUnavl.gif  Radar unavailable image file. 
 

After you have installed this software, it will appear in your Start 
programs menu under the title “Weather Message”. 
 

6. Setting up WxReTran 
After installing WxReTran, you are now ready to setup the software to 
process alarms.  The first step is to start WxReTran.  This is done by 
clicking on Start, Programs, Weather Message, then WxReTran.  The 
following screen will be displayed. 
 

 



 

  

 
This is the main operating window for WxRetran.  The File option menu 
allows you to access the Setup window, Send Morse code identification, 
View the log file, Show Ingest engines running in the background, see 
the Queue Status, and Export and Import the program registry values 
 

System Tab 
To begin the setup process, click on File then Setup.  The following 
screen will appear. 
 

 
 
The setup screens are preloaded with system defaults.  You will have to 
select the type of ingest engine that will be used to receive the EMWIN 
data. 
 
Ingest Path – The directory that will contain the received files to be 
processed by WxRetran. 
 
Ingest Engine – Select WxIngest Serial for the serial port engine or 
WxByte for the Internet engine. 
 
UnZip Received Files – Check this box if you want compressed files to 
be unzipped before they are processed by WxRetran. 



 

  

 
Enable Byte Blaster Server Support – Check this box if you want 
WxReTran to send data to WxBBSrvr (byte blaster server) for 
processing.  (This allows for an Internet backup of your retransmission 
data.) 
 
Purge directories after – Enter the amount of time, in hours, that the 
system should purge the directories used by the retransmission 
program.  Note:  Messages that have been queued, but not sent, will be 
purged after this amount of time. 
 
If all message have been sent, send – Enter the name of the file to be 
sent when WxReTran does not have any weather messages to sent.  
The system defaults to “FillFile.txt”.  The file is located in the WxMesg 
directory and can be edited to contain your local information. 
Insert into – Enter the priority directory name and file name that this file 
should be copied.  The filler file is normally copied to the 
\WxMesg\WxData\RtPri10 directory.  Remember to put the file name on 
the destination path. 
 
Log File Size – Enter the log file size in bytes. 
 
Log Sent Blocks – Check this box to log all of the weather messages 
sent and the times that the morse identification is sent. 
 
Daily Log File – Check this box to store log files for each day in the 
..\WxMesg\WxLogs directory.  The logs for each day are copied to this 
directory.  The log file name is appended with the day number.  These 
logs will be overwritten with the next month’s logs.  After enabling this 
option, you must restart all Weather Message programs.  Note:  
Enabling this option disables the log file size option. 
 
Show Errors – Check this box to have the program pop-up error 
conditions as they occur.  Regardless of this setting, the program will 
write all errors to the log file. 
 

Morse Tab 
 
Click on the Morse tab to setup your morse code callsign (identification). 
 



 

  

 
 
Morse Identify – Enter your FCC issued callsign.  If you don’t require 
identification, leave this field blank. 
 
ID Frequency – Enter the length of time you are required to send your 
callsign.  This normally is 15 minutes for a business band frequency or 
30 minutes for public safety.  If you are in-doubt, check with your local 
two-radio dealer. 
 
Identifier Speed – This field is the morse code speed factor.  The 
default of 25 results in 20 word-per-minute morse code.  You can 
increase or decrease this factor to change the speed. 
 

Port Tab 
 
Click on the Port tab to setup the comm port that is attached to your 
radio modem. 
 



 

  

 
 
Port – Click on the port field to change the comm port. 
 
Data Rate – Click on the data rate field to change the data rate. 
 
The Data Bits, Stop Bits and Parity cannot be changed with the setup 
program.  If you need a different configuration, send an email to 
help@wxmesg.com 
 
Transmitter Delay – Enter the time, in milliseconds, required to key up 
your transmitter. 
 
Transmit For – These fields are used when you don’t have a 
continuous duty transmitter.  You can specify the number of minutes to 
transmit and the number of seconds to pause the transmitter.  If you 
have a continuous duty transmitter, sent the “Transmit For” field to 0 
(zero).  See Appendix B for information on continuous duty. 
 

Priority Tab 
 
You are now ready to begin setting up weather messages to be 
processed.  A brief discussion of priority queues is necessary.  
WxReTran allows you to use 10 different priority queues.  You will need 



 

  

to determine the priority of the weather message that you intend to 
retransmit. 
 
For example, Tornado Warnings, Severe Thunderstorm Warning, Flood 
Warnings, etc. are normally assigned to Priority 1.  Watch products can 
be assigned to Priority 2.  You can use the remaining priority queues for 
other weather products.  Graphic files can be assigned to the lowest 
Priority 10. 
 
All of the priority queue screens are the same.  The following is the 
definition of Priority 1, which applies to all priority queues. 
 

 
 
To add items to this priority queue, enter the weather message file name 
in the Type it here box and press enter.  The file name will appear in 
the list box.  You can use the wild card character ? to match any single 
character in the received file name.  The wild card character * can be 
used to match multiple characters in the received file name. The 
program requires that you enter at least two alpha characters. 
 
For example, to send all messages from Alabama Priority 3, add 
??????al.txt to the list on Priority tab 3. To send all state weather 
roundups for Alabama priority 2, add swr???al.txt to the list on Priority 



 

  

tab 2.  To send tornado warnings for Alabama Priority 1, add tor???al.txt 
to the list on Priority tab 1. 
 
Graphic products can be included by adding ????????.jpg and 
????????.gif to Priority tab following your text products. 
 
To remove a file from the list, click on the item and the click on the 
Remove button.  The file will be remove from the list and will no longer 
be processed. 
 
The Overwrite Pending Files option, if checked, tells the program to 
overwrite a pending file with a newer file, of the same name.  This option 
can be used with a priority queue that will process graphics files.  If a 
graphics file is waiting to be sent and a newer file arrives, the older file 
will be overwritten by the newer file.  Note:  This option should not be 
used with weather text files.  It can cause messages with the same 
name to be overwritten, even though the message may contain different 
weather text. 
 
The Send Files Compressed option allows you to specify if you want 
the files received in this queue to be compressed before they are sent.  
Note:  Compression of single files does not usually result in a lot of 
savings for some file formats.  The Compress tab can be used to 
compress a group of files, which normally results in more savings. 
 

Compress Tab 
 
The Compress tab can be used to specify a group of files that should be 
compressed as a group before being transmitted. 
 



 

  

 
 
To add items to the compress queue, enter the weather message file 
name in the Type it here box and press enter.  The file name will 
appear in the list box.  You can use the wild card character ? to match 
any character in the received file name.  The program requires that you 
enter at least two alpha characters. 
 
The Send block compressed files priority field is used to enter the 
priority queue that will be used to send the files after they are 
compressed. 
 
The Do block compression when files accumulated = is used to 
enter the number of files that should be received before compressing the 
files for transmission. 
 

Discard Tab 
 
The Discard tab is used to enter the file names of messages that you do 
not want sent.   
 



 

  

 
 
By default, WxReTran will discard all files that do not match any of the 
priority or compression queues.  You however, can use this tab to catch 
specific files before they are processed by the priority or compression 
queues. 
 

Copies Tab 
 
The Copies tab is used to setup message files that are to be transmitted 
more than once. 
 



 

  

 
 
If you want to send a weather message more than once, enter the 
number of copies in the Select The Number of Copies field.  Enter the 
file name in the Enter a Keyword field and press enter.  When the 
entered file name is received, it will be duplicated the number of times 
you specify.  You can duplicate a file up to 9 times. 
 

Schedule Tab 
 
The Schedule tab is used to automatically insert an external message 
file into a priority queue. 
 



 

  

 
 
Using the example provided on the screen, enter the time that the 
message should be sent, in military time format.  Followed by a space, 
then the source path and file name, followed by a space and the priority 
queue path and file name.  After entering the schedule, press enter to 
place it in the scheduled transmissions list. 
 
To delete multiple items from the list, select all of the items to be deleted 
and press the delete key. 
 

7. WxReTran Operation 
After initial setup, WxReTran will operate continuously sending received 
weather messages.  In the event that no messages are available, the 
filler file, FillFile.txt, will be sent. 
 
If your transmitting speed is slower than 9600 baud, you should use 
caution when selecting files for retransmission.  At 1200 baud, you can 
only send a fraction of the files that are being transmitted by NOAA.  The 
system log file, RtLog.txt, or Queue Status screen can be reviewed to 
determine if you are overloading your system. 
 
Every six hours, the system writes statistics about program operation.  
These statistics will let you know how many files have been sent, the 
number of filler files that have been sent and the maximum number of 



 

  

files that had to wait in each queue.  These statistics are reset at 
midnight. 
 
The log file may also contain other messages.  An entry will be made in 
the log file each time a message is overwritten.  In addition, any files that 
have not been transmitted before the user specified purge-time, will be 
recorded. 
 
You should review the log file periodically to see if your system is 
overload.  When the log file reaches 100,000 bytes, it is copied to 
RtLog.old and a new log file is created. 
 
Messages that are received for processing are listed in their respective 
priority queue on the screen.  If you want to remove a file from the 
current queue, select the file and press the delete key.  Note:  You 
cannot remove a message that is currently being transmitted. 
 
Note:  If WxReTran is stopped with the window minimized, the next time 
it is started, it will start minimized. 
 
 

8. Including Local Data 
Local data can be inserted into the retransmitted data stream.  To insert 
your own products, copy the file to one of the priority directories.  They 
are named C:\WxMesg\RtPri1 through C:\WxMesg\RtPri10. 
 
If is recommended that you follow the NOAA file naming convention.  A 
product file name should be in 8.3 format.  That is 8 characters before 
the period and 3 characters afterwards.  The extension for weather text 
files should be TXT.  For graphic products, use the appropriate 
extension. 
 
WxRadar can be used to include radar images.  You can also use 
WxLocal to include local weather conditions.  (For information on 
WxLocal, see the Weather Message website.) 
 

9. Byte Blaster Server – Internet Retransmission 
WxBBSrvr is used to retransmit EMWIN data over the Internet or a 
private network.  If you have the bandwidth to spare, you can act as a 
Byte Blaster server for other EMWIN users. 
 
In order for WxBBSrvr to receive data from the ingest engines, you must 
go into the setup screen on one of the ingest engines and check the 



 

  

Enable Byte Blaster Server Support.   If you decide to not use the 
Byte Blaster server, you should uncheck this box. 
 
WxBBSrvr uses TCP/IP port 999, 1000, 1001 and UDP port 9510 to 
communicate with the NOAA host master, Byte Blaster clients and the 
local ingest programs.  If you have a firewall, port 1000 and 1001 must 
be open for WxBBSrvr to work. 
 
Note:  If you want to use WxBBSrvr to retransmit data on a private 
network, send an email to help@wxmesg.com for information to enable 
this operation.  The default configuration requires access to the NOAA 
host master for proper operation. 
 
Note:  WxBBSrvr can receive data from the retransmission software 
WxReTran.  This can be useful if you want to provide a backup for your 
local retransmission system.  If you want to use this option, enable “Byte 
Blaster Support” in the retransmission software.  Using this option will 
make your server a private EMWIN server. 
 
WxBBSrvr runs from the system tray.  The main server window shows 
the servers activity. 
 

 
 
The File menu option allows you to Setup the program, View the log file, 
and Exit the program. 
  
Note:  If WxBBSrvr is stopped with the window minimized, the next time 
it is started, it will start minimized. 
 

Setup 
The setup screen allows you to setup information about your server.   
 



 

  

 
 
Public EMWIN Server - If checked, indicates that any EMWIN user can 
access your server.  Your server’s address will be published to all byte 
blaster clients for public use.  Uncheck this box if your server is for 
private use.  In this case, your address will not be published for public 
use. 
 
Note:  If the program receives data from the retransmission software, it 
will automatically switch to a private server. 
 
The program will automatically determine its TCP/IP address.  In some 
cases, this address may not be correct because of a firewall or other 
settings.  To specify an IP address for this server, check the Use Fixed 
URL box and enter your IP address in the Enter Fixed URL box. 
 
TCP/IP Port – Enter the TCP/IP port for your server.  The default 
EMWIN port is 1000. 
 
Maximum Users - Enter the number of users/clients that can connect to 
your server.  This number can range from 1 to 500.  Take your available 
Internet bandwidth into consideration when you set the number of users. 
 
Server Location - Enter the location for your server.  For example, 
“Weather Message Server 1 – Dadeville, AL”. 
 
Log Activity – Check this box to have the program log connects and 
disconnects to the log file. 
 



 

  

Show Errors – Check this box to have the program pop-up error 
conditions as they occur.  Regardless of this setting, the program will 
write all errors to the log file. 
 
Log File Size – Enter the size in bytes for your log file. 
 
Daily Log File – Check this box to store log files for each day in the 
..\WxMesg\WxLogs directory.  The logs for each day are copied to this 
directory.  The log file name is appended with the day number.  These 
logs will be overwritten with the next month’s logs.  After enabling this 
option, you must restart all Weather Message programs.  Note:  
Enabling this option disables the log file size option. 
 
 

Server Status 
You can view the server’s status by clicking on the Help menu option 
and select Server Status.  Here is a picture of the status screen. 
 

 
 

 

Program Operation 
 

WxBBSrvr waits for byte blaster client connections.  After a client 
connects to the server, the client is required to identify itself at the time 
the connection is established and once every 12 minutes.  If a client 
does not identify itself within the allotted amount of time, the byte blaster 
client is disconnected.   Once the connection is established, the server 
begins to send the byte blaster client data. 
 



 

  

The server maintains a 64K buffer for each connection.  If a client’s 
buffer reaches this maximum, the server will disconnect the client.  A full 
client buffer indicates that the client is not capable of receiving data fast 
enough.  This could be due to Internet congestion or other problems 
related to the Internet. 
 
Should the server receive more connections than are allowed, the server 
will send the byte blaster client a list of the current byte blaster servers 
and disconnect.  This will allow the disconnected byte blaster client to 
locate an available byte blaster server. 
 
The server is in constant communication with the NWS host master.  
The host master maintains a list of private and public byte blaster 
servers.  Every 15 seconds, the byte blaster server reports the number 
of connections and status of the server to the host master. 
 
The host master sends a list of public servers to each byte blaster 
server.  This server list is passed along to each byte blaster client 
connected.  This action allows all of the byte blaster clients to have a 
current list of available byte blaster servers. 
 
Every six minutes, the server requests its IP address from the host 
master.  This serves as a keep-alive packet for the connection to the 
host master.  It also serves to update the host master should a server’s 
IP address change dynamically. 
 
A connection to the host master is required for proper operation.  
Provisions have been made to run the server on a private network 
where an outside connection to the host master is not available.  
Contact Weather Message for setup details. 
 
The server receives data from WxByte (internet), WxIngest (serial port), 
or WxReTran (retransmission).  The ingest programs broadcast their 
received data packets on the TCP/IP loop back.  WxBBSrvr listens for 
this data on UDP port 9510.  Data received from WxByte or WxReTran 
is considered to be 100 percent good.  WxIngest sends an error 
percentage to the byte blaster server.  If the receive quality drops below 
95 percent, the server will not longer send data to the byte blaster 
clients. 
 
Note:  If you use WxByte to supply data to WxBBSrvr, WxByte will only 
connect to servers listed in the WxSatus.txt file.  This file is not 
automatically updated by the byte blaster system.  Although provisions 



 

  

were made to keep this server list updated, they were never 
implemented in the NWS host master software.   At the present time, 
this file contains a list of known servers at EMWIN headquarters. 
 

10. Direct Ingest Setup – Serial Port 
WxIngest is used by WxReTran for direct data feeds from satellite or 
radio modem.  The ingest program can be started automatically by the 
WxReTran Server or manually.  

 

Settings 
 
Once WxIngest is started, you will need to setup some of the program 
defaults, click on the File menu button, then Setup.  You will see this 
screen. 
 

 
 
 
The Settings tab is used to define the communication port parameters 
and backup options.  You will need to enter the com port parameters 
and backup options.   
 
WxIngest supports a backup satellite system, retransmission receiver 
and/or backup by Internet, using WxByte.  If you have a second satellite 
system or retransmission receiver, enter the Comm Port and Baud Rate 
under the backup options.  Also, if you want to use WxByte (internet 
ingest) as a backup, check that option.  The Switch Back Time is used to 



 

  

specify the number of minutes that the program should check back to 
see if the main port is functioning, when using a second serial port.  
 
The Error Rate Greater field sets the error rate percentage for switch 
over to backup.  This field can be set from 5 to 95 percent.  Should the 
error rate, of the received data, exceed the set amount, the program will 
switch over to the backup port or WxByte. 

 
If the main port stops sending data for 15 seconds, the program will 
switch to the backup port, if one is specified.  If the backup port does not 
send data for 15 seconds, it will switch to WxByte, if that option is 
selected.  If the backup port is not specified, it will switch from the main 
port directly to WxByte, if that option is selected. 
  
Based on the Switch Back Time specified, it will change back over to the 
main port.  The process will start all over again.  If no data is received in 
15 seconds, it will switch to the backup port and/or WxByte.  Note:  
Once WxByte is started, it will not be stopped until the program begins 
to receive valid data from one of the serial ports.   
 
When the program switches from serial ingest to WxByte, it will create a 
notification message in each ingest directory.  The product identifier for 
this message is ADMWXM.  If you want to be alerted when the program 
switches between ingest sources, alarm the product ADMWXM, with no 
state or county selected.  The notification message contains the current 
ingest method and computer name. 
 
The Log File Size field allows you to specify this size of your ingest log 
file, IBLog.txt.  The default is 50,000 bytes.   
 
The Log Received Files option causes the program to record the name 
of each weather file received.  The names are recorded in IBFiles.txt. 
 
The Run in Background check box allows you to specify whether you 
want the ingest programs to run in the background.  When this box is 
checked, the ingest programs will not show in the system tray.  Note: 
Changing this option does not take effect until the next time the ingest 
programs are started. 
 
If you have enabled the Run in Background option, you can see the 
ingest screen by going to Weather Message Server, click on the File 
menu option and select Show Ingest. 
 



 

  

The UnZip Received Files option, when checked, will cause the program 
to unzip any compressed files.  This option is normally left unchecked as 
the Weather Message programs automatically unzip compressed files.  
In some applications it may be desirable to unzip the files before they 
are copied to the ingest directory(s). 
 
If you are running the Byte Blaster server, WxBBSrvr, you will need to 
check the Enable Byte Blaster Server Support box.  This will cause the 
ingest program to create data records for processing by the Byte Blaster 
server.  Note: This program communicates with WxBBSrvr using UDP 
port 9510 on the local loop back address. 

 

Ingest Paths 
 
The Ingest Paths tab can be used to override the default Weather 
Message Server ingest path and define additional ingest (distribution) 
paths.  The Ingest Paths screen appears as follows. 
 

 
 
The Ingest Path is defined in the Weather Message Server setup screen 
and would not normally be entered here.  Note:  The Ingest Path can be 
changed if you want to deposit the received messages in a directory 
other than the one established for Weather Message Server.   
 
The Additional Distribution Paths can be used to place a copy of the 
received weather text in different directories for processing by other 
programs.  For example if you use Weather Message to receive your 



 

  

weather text, you can put a copy of the received messages in a directory 
for processing by RealEMWIN or the Weather Message Retransmission 
program. 
 
Note:  Changing the Ingest and Additional Distribution Paths on this 
screen will automatically change them for WxByte. 
 

Operation 
 
The WxIngest processing screen appears as follows. 
 

 
 
 
The File menu option allows you to Setup the program, Reset the error 
statistics, View the log file, View Files Received Log and Exit the 
program.  A Port option will be present when you have a backup port 
specified.  This option can be used to switch WxIngest to the backup 
port. 
 
The main screen shows the status of incoming messages.  The Data 
Source field indicates which source is being used to receive the EMWIN 
data.  Should the program stop receiving data, it will display “Data Alert” 
to the right of the Data Source field in a red box. 
 



 

  

The Processing File, Block and File Size fields show information on the 
received file.  A green or red led appears to the right of the Processing 
File field.  This led will normally appear green.  If any of the blocks 
received for this message are defective, the led will change to red. 
 
The total blocks field shows the total number of blocks received since for 
a one-hour period, the bad blocks field shows how many of the total 
blocks received were defective.  The bad blocks field is a total of the 
packet length, bad header and check sum fields.  The block count field 
counts the number of messages that any blocks missing. 
 
The error percent field shows the error percentage of the blocks 
received verses bad blocks.  You want this field as low as possible.  The 
background color of this field will change based on the quality of the 
received data.  If the background is white, the received data has 10% or 
fewer errors.  If the background is yellow, the received data has between 
10% and 20% errors.  If the background is red the received data has an 
error rate greater than 20%.   

 
If the received message is text, you will see the first 1024 characters of 
the message in the text box.  This shows the text for the block just 
received, it does not show the complete message. 
 
The ingest program will attempt to repair defective messages, if a 
duplicate message is received.  Note:  It is recommended that you run 
the ingest program on a computer that will not be used for normal user 
programs.  The processing of serial data can be interrupted by other 
software programs, which can result in lost weather messages. 
 
Note:  If WxIngest is stopped with the window minimized, the next time it 
is started, it will start minimized. 
 
Note:  While the program is using WxByte as a backup data source, the 
fields on the screen will not be updated.  They will resume showing data 
when the main serial port begins to receive data. 
 
Note:  The program supports a second log file.  The second format uses 
a fixed field size for easy analysis.  This log file is never purged and 
remains until the user deletes the log files.  To enable this logging 
option, create the directory “NwsLogs” in the c:\program files\WxMesg 
directory. 
 



 

  

Note:  Some computers may detect your satellite receiver as a 
serial mouse.  This generally occurs when the satellite receiver is 
turned on when booting the computer.  If this occurs, your mouse 
will begin to move on it’s own.  To correct this problem, turn off the 
satellite receiver.  Download the comdisable tool from Microsoft at 
this web address  Settings 
 
WxIngest is used by Weather Message for direct data feeds from 
satellite or radio modem.  The ingest program can be started 
automatically by the Weather Message Server or manually. Once 
started, you will need to setup some of the program defaults, click on the 
File menu button, then Setup.  You will see this screen. 
 

 
 
 
The Settings tab is used to define the communication port parameters 
and backup options.  You will need to enter the com port parameters 
and backup options.   
 
WxIngest supports a backup satellite system, retransmission receiver 
and/or backup by Internet, using WxByte.  If you have a second satellite 
system or retransmission receiver, enter the Comm Port and Baud Rate 
under the backup options.  Also, if you want to use WxByte (internet 
ingest) as a backup, check that option.  The Switch Back Time is used to 
specify the number of minutes that the program should check back to 
see if the main port is functioning, when using a second serial port.  
 



 

  

The Error Rate Greater field sets the error rate percentage for switch 
over to backup.  This field can be set from 5 to 95 percent.  Should the 
error rate, of the received data, exceed the set amount, the program will 
switch over to the backup port or WxByte. 

 
If the main port stops sending data for 15 seconds, the program will 
switch to the backup port, if one is specified.  If the backup port does not 
send data for 15 seconds, it will switch to WxByte, if that option is 
selected.  If the backup port is not specified, it will switch from the main 
port directly to WxByte, if that option is selected. 
  
Based on the Switch Back Time specified, it will change back over to the 
main port.  The process will start all over again.  If no data is received in 
15 seconds, it will switch to the backup port and/or WxByte.  Note:  
Once WxByte is started, it will not be stopped until the program begins 
to receive valid data from one of the serial ports.   
 
When the program switches from serial ingest to WxByte, it will create a 
notification message in each ingest directory.  The product identifier for 
this message is ADMWXM.  If you want to be alerted when the program 
switches between ingest sources, alarm the product ADMWXM, with no 
state or county selected.  The notification message contains the current 
ingest method and computer name. 
 
The Log File Size field allows you to specify this size of your ingest log 
file, IBLog.txt.  The default is 50,000 bytes.   
 
The Log Received Files option causes the program to record the name 
of each weather file received.  The names are recorded in IBFiles.txt. 
 
The Run in Background check box allows you to specify whether you 
want the ingest programs to run in the background.  When this box is 
checked, the ingest programs will not show in the system tray.  Note: 
Changing this option does not take effect until the next time the ingest 
programs are started. 
 
If you have enabled the Run in Background option, you can see the 
ingest screen by going to Weather Message Server, click on the File 
menu option and select Show Ingest. 
 
The UnZip Received Files option, when checked, will cause the program 
to unzip any compressed files.  This option is normally left unchecked as 
the Weather Message programs automatically unzip compressed files.  



 

  

In some applications it may be desirable to unzip the files before they 
are copied to the ingest directory(s). 
 
If you are running the Byte Blaster server, WxBBSrvr, you will need to 
check the Enable Byte Blaster Server Support box.  This will cause the 
ingest program to create data records for processing by the Byte Blaster 
server.  Note: This program communicates with WxBBSrvr using UDP 
port 9510 on the local loop back address. 

 

Ingest Paths 
 
The Ingest Paths tab can be used to override the default Weather 
Message Server ingest path and define additional ingest (distribution) 
paths.  The Ingest Paths screen appears as follows. 
 

 
 
The Ingest Path is defined in the Weather Message Server setup screen 
and would not normally be entered here.  Note:  The Ingest Path can be 
changed if you want to deposit the received messages in a directory 
other than the one established for Weather Message Server.   
 
The Additional Distribution Paths can be used to place a copy of the 
received weather text in different directories for processing by other 
programs.  For example if you use Weather Message to receive your 
weather text, you can put a copy of the received messages in a directory 
for processing by RealEMWIN or the Weather Message Retransmission 
program. 



 

  

 
Note:  Changing the Ingest and Additional Distribution Paths on this 
screen will automatically change them for WxByte. 
 

Operation 
 
The WxIngest processing screen appears as follows. 
 

 
 
 
The File menu option allows you to Setup the program, Reset the error 
statistics, View the log file, View Files Received Log and Exit the 
program.  A Port option will be present when you have a backup port 
specified.  This option can be used to switch WxIngest to the backup 
port. 
 
The main screen shows the status of incoming messages.  The Data 
Source field indicates which source is being used to receive the EMWIN 
data.  Should the program stop receiving data, it will display “Data Alert” 
to the right of the Data Source field in a red box. 
 
The Processing File, Block and File Size fields show information on the 
received file.  A green or red led appears to the right of the Processing 



 

  

File field.  This led will normally appear green.  If any of the blocks 
received for this message are defective, the led will change to red. 
 
The total blocks field shows the total number of blocks received since for 
a one-hour period, the bad blocks field shows how many of the total 
blocks received were defective.  The bad blocks field is a total of the 
packet length, bad header and check sum fields.  The block count field 
counts the number of messages that any blocks missing. 
 
The error percent field shows the error percentage of the blocks 
received verses bad blocks.  You want this field as low as possible.  The 
background color of this field will change based on the quality of the 
received data.  If the background is white, the received data has 10% or 
fewer errors.  If the background is yellow, the received data has between 
10% and 20% errors.  If the background is red, the received data has an 
error rate greater than 20%.   

 
If the received message is text, you will see the first 1024 characters of 
the message in the text box.  This shows the text for the block just 
received, it does not show the complete message. 
 
The ingest program will attempt to repair defective messages, if a 
duplicate message is received.  Note:  It is recommended that you run 
the ingest program on a computer that will not be used for normal user 
programs.  The processing of serial data can be interrupted by other 
software programs, which can result in lost weather products. 
 
Note:  If WxIngest is stopped with the window minimized, the next time it 
is started, it will start minimized. 
 
Note:  While the program is using WxByte as a backup data source, the 
fields on the screen will not be updated.  They will resume showing data 
when the main serial port begins to receive data. 
 
Note:  The program supports a second log file.  The second format uses 
a fixed field size for easy analysis.  This log file is never purged and 
remains until the user deletes the log files.  To enable this logging 
option, create the directory “NwsLogs” in the c:\program files\WxMesg 
directory. 
 
Note:  Some computers may detect your satellite receiver as a serial 
mouse.  This generally occurs when the satellite receiver is turned on 
when booting the computer.  If this occurs, your mouse will begin to 



 

  

move on it’s own.  To correct this problem, turn off the satellite receiver.  
Download the comdisable tool from Microsoft at this web address 
http://support.microsoft.com/default.aspx?scid=kb;en-us;819036 
 

11. Direct Ingest Setup – Internet 
 
WxByte is used by WxReTran for Internet reception of the EMWIN data 
stream.  The ingest program can be started automatically by the 
Weather Message Server or manually.   
 
It uses information from Internet weather servers to maintain a list of 
servers available.  It attempts to connect to the first available server.  
Should a server stop functioning, WxByte will attempt to contact the next 
available server.  Every 10 minutes, WxByte receives an updated list of 
servers. 
 
WxByte uses TCP/IP port 1000 to communication with the servers.  If 
you have a firewall, port 1000 must be open for WxByte to work.    
Recently the National Weather Service started testing servers on ports 
21 and 22.  These ports may also be required in the future. 
 
The WxByte processing screen appears as follows. 
 

 
 
The File menu option allows you to Setup the program, Show Details, 
View the log file, View Files Received Log and Exit the program.  To see 
the current server IP address and/or the list of servers, select WxByte 
Status from the Help menu. 
 



 

  

The Server field shows the TCP/IP address of the server that is 
providing you with EMWIN data.  The Connect Time is the amount of 
time that you have been connected to this server.   
 
The total blocks field shows the total number of blocks received for a 
one-hour period, the bad blocks field shows how many of the total 
blocks received were defective.  The bad blocks field is a total of the bad 
header and check sum fields.  The block count field counts the number 
of messages that had any blocks missing.  The error percent field shows 
the error percentage of the blocks received verses bad blocks.   
 
The status information, included the decoded message display can be 
removed by clicking on the up button or resizing the screen.  To show 
the status information and decoded message drag down on the bottom 
of the window. 
 
Note:  If WxByte is stopped with the window minimized, the next time it 
is started, it will start minimized. 
 

Settings 
 
The Setup menu allows you to specify several options.   
 

 
  
The Auto-Reconnect on Server Disconnect should be checked if you 
want WxByte to try to connect to another server if it becomes 
disconnected.  The Auto-Update Server List should be checked if you 



 

  

want WxByte to automatically maintain a list of available servers.  If 
WxByte does not maintain this list, you will need to manually update the 
WxSvrus.txt file to include the servers that you want it to try to establish 
a connection.   
 
If you are running the Byte Blaster server, WxBBSrvr, you will need to 
check the Enable Byte Blaster Server Support box.  This will cause the 
ingest program to create data records for processing by the Byte Blaster 
server.  Note: This program communicates with WxBBSrvr using UDP 
port 9510 on the local loop back address. 
 
A fixed TCP/IP address can be used.  Enter the fixed TCP/IP address in 
the Enter Fixed URL field.  Click on Use Fixed URL, to only connect to 
that specific server. 
 
The Timeout seconds on loss of data is set by default to 15 seconds.  
You can change this within the range of 15 to 600 seconds. 

 
The Log File Size field allows you to specify this size of your ingest log 
file, IBLog.txt.  The default is 50,000 bytes.  
  
The Log Received Files option causes the program to record the name 
of each weather file received.  The names are recorded in IBFiles.txt. 
 
The Run in Background check box allows you to specify whether you 
want the ingest programs to run in the background.  When this box is 
checked, the ingest programs will not show in the system tray.  Note: 
Changing this option does not take effect until the next time the ingest 
programs are started. 
 
If you have enabled the Run in Background option, you can see the 
ingest screen by going to Weather Message Server, click on the File 
menu option and select Show Ingest. 
 
The Weather Wire check box allows you to use Weather Wire as a 
backup for EMWIN.  Checking this box will cause the program to 
automatically start WxWW2000 when EMWIN data is not available.  This 
requires registration for Weather Wire; see the Weather Wire section for 
details.   
 
When the program switches from WxByte to WxWW2000, it will create a 
notification message in each ingest directory.  The product identifier for 
this message is ADMWXM.  If you want to be alerted when the program 



 

  

switches between ingest sources, alarm the product ADMWXM, with no 
state or county selected.  The notification message contains the current 
ingest method and computer name. 
 
The UnZip Received Files option, when checked, will cause the program 
to unzip any compressed files.  This option is normally left unchecked as 
the Weather Message programs automatically unzip compressed files.  
In some applications it may be desirable to unzip the files before they 
are copied to the ingest directory(s). 

 

Ingest Paths 
 
The Ingest Paths tab can be used to override the default Weather 
Message Server ingest path and define additional ingest (distribution) 
paths.  The Ingest Paths screen appears as follows. 
 

 
  
The Ingest Path is defined in the Weather Message Server setup screen 
and would not normally be entered here.  Note:  The Ingest Path can be 
changed if you want to deposit the received messages in a directory 
other than the one established for Weather Message Server.   
 
The Additional Distribution Paths can be used to place a copy of the 
received weather text in different directories for processing by other 
programs.  For example if you use Weather Message to receive your 
weather text, you can put a copy of the received messages in a directory 
for processing by RealEMWIN or the Weather Message Retransmission 
program. 



 

  

 
Note:  Changing the Ingest and Additional Distribution Paths on this 
screen will automatically change them for WxIngest. 
 
Note: The byteblaster protocol, used by the Internet weather servers, 
requires an email address to be sent for verification.  Make sure that you 
enter an email address on the Weather Message Server Email setup 
screen.  Otherwise, when the weather server you are connected to 
reaches 90% capacity your connection will be disconnected. 
 
Note:  The program supports a second log file.  The second format uses 
a fixed field size for easy analysis.  This log file is never purged and 
remains until the user deletes the log files.  To enable this logging 
option, create the directory “NwsLogs” in the c:\program files\WxMesg 
directory. 
 
 

12. WxRadar 
 

WxRadar is a support program that can be used to automatically retrieve 
radar images.  It can be used to retrieve a specific radar site for viewing 
on the screen, or schedule single or multiple radar sites for ingesting by 
Weather Message or other programs.  WxRadar requires Internet 
access to retrieve the radar images. 
 
If you plan to use WxRadar to retrieve images on a schedule, it is 
recommended that it be placed in the startup box on Windows.  This will 
insure that the program is automatically started each time the computer 
is booted.   
 
The main screen appears below. 
 



 

  

 
 

In the standalone mode, you can view a selected radar site image.  
Select the state, radar site, the image type, layers to be displayed and 
click View.  The program will retrieve the selected site.  
 



 

  

 
 
To view a different site or image, select that site or image and click on 
View. 
 
The image can be resized to fit the display window or zoomed for closer 
inspection.  To activate these features, right click on the image and 
select one of the displayed options. 
 
The display image can also be printed.  Click on the File menu option 
and select Print.  The image will be printed to your default printer. 
 
Note:  If WxRadar is stopped with the window minimized, the next time it 
is started, it will start minimized. 
 
Note:  If the program cannot download the requested radar image, a 
“Radar Unavailable” image will be displayed.  The “Radar Unavailable” 
image can be customized by changing the “RadUnavl.gif” file. 
 
Automatically Retrieving Images for Ingest 
 
WxRadar can also be setup to retrieve images based on a schedule.  
Images that are received will be copied to directories for other programs 



 

  

to process.  You can use it in conjunction with Weather Message to ftp 
images to a website or WxReTran for EMWIN retransmission. 
 
Images processed by Weather Message Server can be made available 
to the Weather Message Client Image Viewer.  The Image Viewer can 
then be used to animate the received radar images. 
 

Settings 
 
Before establishing the schedule, you will need to setup the ingest 
directories.  Click on File, then Setup.  You will see the following screen. 
 

 
 

 
The Timeout field allows you to specific the maximum amount of time 
the program will wait on the NOAA servers to respond.  

 
The Log File Size field allows you to specify this size of your log file, 
RadLog.txt.  The default is 50,000 bytes.   
 
When the program retrieves images from the defined schedule, it does 
not display these images in the preview window.  The Show Image 
check box, when checked, causes the program to show each image as it 
is received. 
 
The Use Defined Ingest Paths check box, when checked, will cause the 
program to use the ingest paths defined in the ingest programs, WxByte 



 

  

and WxIngest.  If you want to define your own ingest paths for WxRadar, 
remove this check. 
 
The Firewall / Proxy button allows you to setup firewall / proxy 
requirements for WxRadar.  See the Firewall / Proxy section for 
additional information.   
 
The Image Type list allows you to select an image format for the 
received image.  Radar images are received by default in GIF format.  
You can select GIF, JPG, PNG, BMP, and TIF formats. 
 
The Drop Duplicates checkbox, when checked, will create a CRC32 
checksum on each received image.  If the next image received is a 
duplicate, the program will not process the image.  
 
Firewall / Proxy Settings 
 
The Firewall / Proxy screen allows you to setup access through a 
firewall and/or proxy.  The setup screen supports firewall settings for the 
http protocol.  It also supports proxy access for the http protocol.  The 
setup screen follows: 
 

 
 

For a HTTP firewall, enter the domain name or TCP/IP address of the 
firewall in the Host Name field. 
 
Enter the Port number for the firewall. 
 
If required, enter a User Name and Password.  This should be a user 
name and password setup in the firewall. 
 



 

  

Select the Type of firewall.  Valid entries are 1-Tunnel, 2-Socks version 
4, or 3-Socks version 5. 

 
 

 
 

For a Proxy access, enter the domain name or TCP/IP address of the 
proxy in the Host Name field. 
 
Enter the Port number for the firewall. 
 
If required, enter a User Name and Password.  This should be a user 
name and password setup for the proxy. 
 
If HTTP version 1.0 is required for the proxy server, check this box. 

 

Ingest Paths 
 
 



 

  

 
 
Enter the ingest directories that you want the received files copied to 
when they are received. 
 
Note:  If the Use Defined Ingest Paths setting is checked, you will not be 
able to change the paths listed. 
 

Setting up the Schedule 
 
For the main program screen, select Schedule.  The screen will change 
to the scheduling mode.  You will see the following screen. 
 



 

  

 
 
Select the State, Radar Site, Image, Layers, File Name for ingest and 
Interval to retrieve.  Click on the Add button to schedule that radar site.  
To remove a site, click on the site in the list and press the Delete button. 
 
Note:  If you do not enter a file name, WxRadar will create the radar file 
name in the format, “RAD” plus the last three letters of the radar site 
plus the 2 digit state abbreviation plus “.gif”.  For example, the file name 
for KMXX would be RADMXXAL.gif. 
 
The scheduled radar images will be retrieved based on the interval 
period specified.  Valid intervals are 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 
20, 25, 30, 35, 40, 45, 50, 55 and 60 minutes. 
 
The programs operation is logged to the file RadLog.txt.  To view this log 
file, click on File and View Log.  The log file will contain an entry for each 
time it attempts to retrieve a radar image.  It will also contain any error 
conditions. 
 
Note:  The selected images will be retrieved according to the schedule 
established.  If you want to retrieve all images immediately, click on the 
Retrieve Now menu button. 
 



 

  

 
13. Future Direction 

This software will be enhanced only by user recommendations.  If you 
would like for it to do something different, please let me know. 
 

14. Program Assistance 
You can contact the program author by email at this address 
danny@wxmesg.com.  If you use mail, sent correspondence to Danny 
Lloyd, 203 Old Shepard Road, Dadeville, Alabama 36853. 
 

 
Notes: 
 
RealEMWIN is copyrighted by Skywatch Services. 
Weather Message, WxMesg, WxReTran and associated programs copyrighted 
by Danny Lloyd, 2002 - 2005. 



 

  

Appendix A 

Upgrading from a Previous Version 
 
 
If you are upgrading a version of retransmission software provided from Maryland 
Radio Center, Xenocode, or Emwin Pro, the following information will be helpful. 
 
Upgrade from 16-bit version. 
 
To upgrade from the 16-bit version, install WxReTran according to this manual.  
After installation, copy the following files to their corresponding WxReTran file. 
 
 C:\weather\mrcfiles.txt   c:\WxMesg\FillFile.txt 
 C:\weather\hipri.txt  c:\WxMesg\RtList1.txt 
 C:\weather\normal.txt  c:\WxMesg\RtList5.txt 
 C:\weather\compress.txt c:\WxMesg\RtList9.txt 
 C:\weather\delete.txt  c:\WxMesg\RtList11.txt 
 C:\weather\txsked.txt  c:\WxMesg\RtSched.txt 
 
Check all of the setup screens and enter information for your retransmission site.  
Note:  The 16-bit version processed all priority lists before checking the discard 
list.  WxReTran processes the discard list first, because of this, you may need to 
change the file names that appear in the discard list.  Note:  If you have 
????????.TXT in your discard list, no text weather files will be transmitted. 
 
If you use the scheduler, you will need to change the paths associated with the 
source file and destination priority directory.  Failure to do so will cause your 
schedule to be ignored. 
 
Note:  The path “c:\WxMesg\” refers to the directory that you installed WxReTran.  
If you installed the program in a different directory, use your installation path. 
 
 
Upgrade from 32-bit version. 
 
To upgrade from the 32-bit version, install WxReTran according to this manual.  
After installation, copy the following files to their corresponding WxReTran file. 
 
 C:\weather\fillfile.txt  c:\WxMesg\FillFile.txt 
 C:\weather\prilst0.txt  c:\WxMesg\RtList0.txt 
 C:\weather\prilst1.txt  c:\WxMesg\RtList1.txt 
 C:\weather\prilst2.txt  c:\WxMesg\RtList2.txt 



 

  

 C:\weather\prilst3.txt  c:\WxMesg\RtList3.txt 
 C:\weather\prilst4.txt  c:\WxMesg\RtList4.txt 
 C:\weather\prilst5.txt  c:\WxMesg\RtList5.txt 
 C:\weather\prilst6.txt  c:\WxMesg\RtList6.txt 
 C:\weather\prilst7.txt  c:\WxMesg\RtList7.txt 
 C:\weather\prilst8.txt  c:\WxMesg\RtList8.txt 
 C:\weather\prilst9.txt  c:\WxMesg\RtList9.txt 
 C:\weather\prilst10.txt  c:\WxMesg\RtList10.txt 
 C:\weather\prilst11.txt  c:\WxMesg\RtList11.txt 
 C:\weather\prilst12.txt  c:\WxMesg\RtList12.txt 
 C:\weather\schedule.txt c:\WxMesg\RtSched.txt 
 
Check all of the setup screens and enter information for your retransmission site. 
 
If you use the scheduler, you will need to change the paths associated with the 
source file and destination priority directory.  Failure to do so will cause your 
schedule to be ignored. 
 
Note:  The path “c:\WxMesg\” refers to the directory that you installed WxReTran.  
If you installed the program in a different directory, use your installation path. 



 

  

Appendix B 

Interface Specifications 
 
WxReTran communicates with your external modulator/modem to send the 
EMWIN data.  The following RS232 connections should be made, depending on 
your interface. 
 
 RS232 Pin   Description 

2 Transmit data – Outgoing EMWIN data 
4 Request to Send (RTS) – Push to Talk (PTT) 
7 Ground 
20 Data Terminal Ready – Power for modulator 

 
WxRetran will set the DTR line high when the program starts.  The DTR line can 
be used to supply power to the modulator.  The RTS line goes high when the 
program wants to transmit data.  The program will wait a user definable amount 
of time after switching the PTT on before transmitting data.  This will insure that 
the transmitter has adequate time to come up. 
 
Morse code, used for radio identification, is generated by turning the PTT on and 
off.  If your modulator/modem does not support identification by this method, 
external circuitry will be required. 
 
The modulator will need to be connected to your transmitted.  See the modulator 
instructions for installation specifics. 
 
Note:  If you plan to transmit EMWIN data at all times, you will need a continuous 
duty transmitter.  A continuous duty transmitter is rated for this type of service.  
Ordinary transmitters do not have adequate cooling for continuous service.  
Consult your local two-way radio dealer for information. 



 

  

Appendix C 

Example Configurations 
 
The following tables contain example configurations provided by two EMWIN 
retransmission operators. 
 

Lee County Alabama 
 

Priority Queue 1 Priority Queue 6 
cem???al.txt 
tor???al.txt 
svr???al.txt 

sps???ar.txt 
sps???fl.txt 
sps???ga.txt 
sps???la.txt 
sps???ms.txt 
sps???tn.txt 
svs???ar.txt 
svs???fl.txt 
svs???ga.txt 

svs???la.txt 
svs???ms.txt 
svs???tn.txt 
hls?????.txt 
haat??us.txt 
hadt??us.txt 
haft??us.txt 
hapt??us.txt 
hawt??us.txt 

Priority Queue 2 Priority Queue 7 
ffw???al.txt 
flw???al.txt 
wsw???al.txt 
npw???al.txt 
cem?????.txt 

pns???ar.txt 
pns???fl.txt 
pns???ga.txt 
pns???la.txt 
pns???ms.txt 
pns???tn.txt 

npw???ar.txt 
npw???fl.txt 
npw???ga.txt 
npw???la.txt 
npw???ms.txt 
npw???tn.txt 

Priority Queue 3 Priority Queue 8 
ffa???al.txt 
ffs???al.txt 
sps???al.txt 
svs???al.txt 
sls???al.txt 
fls???al.txt 
now???al.txt 
pns???al.txt 
lsr???al.txt 

sel?????.txt 
saw?????.txt 
sev?????.txt 
wwa?????.txt 
sel?.txt 
saw?.txt 
sev?.txt 
wwa?.txt 

lsr???ar.txt 
lsr???fl.txt 
lsr???ga.txt 
lsr???la.txt 
lsr???ms.txt 
lsr???tn.txt 

zfp???ar.txt 
zfp???fl.txt 
zfp???ga.txt 
zfp???la.txt 
zfp???ms.txt 
zfp???tn.txt 

Priority Queue 4 Priority Queue 9 
tor???ar.txt 
tor???fl.txt 
tor???ga.txt 
tor???la.txt 
tor???ms.txt 
tor???tn.txt 
svr???ar.txt 
svr???fl.txt 
svr???ga.txt 
svr???la.txt 
svr???ms.txt 
svr???tn.txt 

ffw???ar.txt 
ffw???fl.txt 
ffw???ga.txt 
ffw???la.txt 
ffw???ms.txt 
ffw???tn.txt 
flw???ar.txt 
flw???fl.txt 
flw???ga.txt 
flw???la.txt 
flw???ms.txt 

??????ga.txt 
???alrga.txt 
???wnsus.txt 
???mkcus.txt 
???spcus.txt 
???necus.txt 
???wbcus.txt 

Priority Queue 5 Priority Queue 10 



 

  

sls???ar.txt 
sls???fl.txt 
sls???ga.txt 
sls???la.txt 
sls???ms.txt 
sls???tn.txt 
ffa???ar.txt 

ffa???fl.txt 
ffa???ga.txt 
ffa???la.txt 
ffa???ms.txt 
ffa???tn.txt 
??????al.txt 

g08cirus.jpg 
imgwwaus.gif 
radrefus.gif 
trkatlus.gif 
moddy1us.gif 
moddy2us.gif 

 
Dallas / Fort Worth Texas 

 
Priority Queue 1 Priority Queue 6 

ema?????.txt 
sel?????.txt 
nowftwtx.txt 
sls?????.txt 
saw?????.txt 
wwa?????.txt 
swomkcus.txt 
tor???tx.txt 
svr???tx.txt 
svs???tx.txt 
ffw???tx.txt 
ffa???tx.txt 

ffs???tx.txt 
flw???tx.txt 
fls???tx.txt 
wsw???tx.txt 
npw???tx.txt 
sps???tx.txt 
cem???tx.txt 
mws???tx.txt 
sevmkcus.txt 
awg?????.txt 
pwo???tx.txt 
nowfwdtx.txt 

swr???nm.txt 
sws???nm.txt 
afd???nm.txt 
swr???ok.txt 
sws???ok.txt 
afd???ok.txt 
swr???la.txt 
sws???la.txt 
afd???la.txt 

Priority Queue 2 Priority Queue 7 
tor???ok.txt 
tor???la.txt 
tor???nm.txt 
svr???ok.txt 
svr???la.txt 
svr???nm.txt 
svs???la.txt 
svs???ok.txt 
svs???nm.txt 
ffw???la.txt 
ffw???ok.txt 
ffw???nm.txt 
ffa???la.txt 
ffa???ok.txt 
ffa???nm.txt 
ffs???la.txt 
ffs???ok.txt 
ffs???nm.txt 
flw???ok.txt 
flw???la.txt 

flw???nm.txt 
fls???la.txt 
fls???ok.txt 
fls???nm.txt 
wsw???ok.txt 
wsw???la.txt 
wsw???nm.txt 
npw???ok.txt 
npw???la.txt 
npw???nm.txt 
sps???la.txt 
sps???ok.txt 
sps???nm.txt 
cem???la.txt 
cem???ok.txt 
cem???nm.txt 
pwo???ok.txt 
pwo???nm.txt 
lsrftwtx.txt 

faadfwus.txt 
uvi???us.txt 
dy????us.txt 
six???us.txt 
swx3??us.txt 
swxd??us.txt 
fee?????.txt 

Priority Queue 3 Priority Queue 8 
smw???la.txt 
smw???tx.txt 
smw???ms.txt 
swo?????.txt 

moddy1us.gif 
moddy2us.gif 
moddy3us.gif 
modhalus.gif 
modtorus.gif 
modpdpus.gif 
modqp1us.gif 

modqp2us.gif 
modqp3us.gif 
modqp5us.gif 
modwndus.gif 
modtmpus.gif 
cliftwtx.txt 
rtpftwtx.txt 

Priority Queue 4 Priority Queue 9 
hwoftwtx.txt radallus.gif 

swr???ar.txt 
afd???ar.txt 

Priority Queue 5 Priority Queue 10 



 

  

??????tx.txt 
ha????us.txt 
cwfhgxus.txt 
nshhgxus.txt 
nshcrpus.txt 
imgwwaus.gif 

afd???tx.txt 
swr???tx.txt 
sws???tx.txt 
ffgftwtx.txt 
fwfftwtx.txt 

g08cirus.jpg 
imgwwaus.gif 
radrefus.gif 
trkatlus.gif 
moddy1us.gif 
moddy2us.gif 

 



 

  

Appendix D - What is Weather Wire 
  

The National Oceanic and Atmospheric Administration Weather Wire Service, 
NWWS, is a satellite broadcast system that delivers critical National Weather 
Service information. DynCorp Systems & Solutions operates NWWS.  This 
service is available using their proprietary C-band service or Internet connection.  
This system routinely delivers 99 percent of all messages within six seconds. 

Established in October 2000, the system collects data from 141 U.S. Weather 
Centers and special centers around the country, and broadcasts a continuous 
stream of alphanumeric information.  Users may receive as much of the 
information as they want, for a low, fixed annual fee. Current customers include 
radio, television, and cable stations; universities; state and federal emergency 
management services; and many other government agencies. 

For more information on NWWS see DynCorp’s website at 
http://www.weatherwire.net or NOAA’s website at 
http://www.nws.noaa.gov/nwws/. 

 
 


